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The ultimate guide to Gmail, Gsheets, and Mac Productivity:m

m -Explore:

Need to do some number crunching?

Let Google's Al do the work for you.

*Highlight the range of data.

*Move your cursor to the starburst-shaped icon in the bottom right corner.

Click "Explore" — Charts, analytics, & detailed info. generated automatically.
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Date Email Open Rate
Sent Increase
1/1/2021 25.00%
2/1/2021 15.00%
3/1/2021 500.00%
4/1/2021 75.00%
5/1/2021 119.00%
6/1/2021 225.00%
7/1/2021 5.00%
8/1/2021 315.00%
9/1/2021 425.00%
10/1/2021 12.00%
[
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m -Look like you're working (when you're not)

Gmail offers scheduling... Who knew?

No need to be physically sitting at your desk, or hammering out emails on your phone after hours.
«Compose your message

*Click the dropdown next to "send"
*Click "schedule send"



Computer Android  iPhone & iPad

1. On your computer, go ta Gmail & .

2. At the top left, click Compose.

3. Create your email.

4, At the bottom left next to “Send," click the dropdown arrow =
5, Click Schedule send.

Mote: You can have up to 100 scheduled emails.

Computer Android iPhone & iPad Computer  Androld  iPhone & iPad

1. On your iPhone or iPad, open the Gmail app . 1. On your Android phone or tablet, open the Gmail app M.

2. At the bottom right, tap Compose + . 2. At the bottom right, tap Compose + .

3. Create your email. 3. Create your email.
4. At the top right, tap More «.. 4. At the top right, tap More :

5. Tap Schedule send » select an option. 5. Tap Schedule send > select an option.

Note: You can have up to 100 scheduled emails. Note: You can have up to 100 scheduled emails.

m -Specific Screenshots:

SHIFT+CMD+3 will capture your entire screen.

Did you know you can also narrow your capture to a specific portion?

It's easy, & now that | know it exists, | use it every day.

A simple SHIFT+CMD+4 and you're on your way.



How to capture a portion of the screen
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1. Press and hold these three keys together: Shift, Command, and 4.

2. Drag the crosshair % to select the area of the screen to capture. To move the selection, press and hold
Space bar while dragging. To cancel taking the screenshot, press the Esc (Escape) key.

[ ] ® [ < )] @ inspirationarchives.com

]

INSPIRATION ARCHIVES
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3. To take the screenshot, release your mouse or trackpad button.

4. If you see a thumbnail in the corner of your screen, click it to edit the screenshot. Or wait for the
screenshot to save to your desktop.

m -Finance:

Monitor stock prices, spot trends, & quickly review historical data using =GOOGLEFINANCE.
Want to see the last 60 days of closing prices for a specific ticker symbol?

Paste the formula below & voila!

=GOOGLEFINANCE("NASDAQ:TSLA","price", TODAY()-60,TODAY())
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m -Remove those annoying tabs:

Maybe it's just me, but | hate the "social & promotions" tabs that come with the standard Gmail setup.
Let's trash them, & get all your mail in one place.

*Head to settings > all-settings

*Inbox > categories
*Choose which to show as tabs




Primary
Social
Promotions
(J Updates
(J Forums

Starred messages
Include starred in Primary

Bundling in Promotions
Enable bundling of top promo emails in Promotions

Choose which message categories to show as inbox
tabs. Other messages will appear in the Primary tab.

Deselect all categories to go back to your old inbox.

m -Keyboard Shortcuts:

| was sitting in my office recently & noticed one of my coworkers seemingly flying through tasks.
Without ever using his mouse.

| thought, "man, I've got to learn keyboard shortcuts.”

With this in mind, here are the basics to get us started.



Keyboard shortcuts on your Mac

You can press key combinations to do things on your iMac that you'd normally do with a trackpad, mouse,
or other device. Here's a list of commonly used keyboard shortcuts.

Shortout Description

Cammarnd-x Cut the selected itam and copy it to the Clipboard.

Cammand-C Copy the selected item to the Clipboard.

Cammand-V Paste the contents of the Clipboard into the current documant ar app.
Cammand-2 Undo the previous command. Press Command-Shift-2 to redo.
Cammand-4 Select all itams.

Command=F Opan a Find window, or find items in a documant.

Cammand-G Find the next occurrence of the item you're searching for. Press Command-

Shift-5 to find the previous cccurrence.

Cammand=-H Hida the windows of the front app. Press Command-Option-H to view the
front app but hide all other apps.

Cammand-h Minimize the front window to the Dock. Press Command-0Option-M to
minimize all windows of the front apgp.

Cammand=M Opan a new documant or window.

Cammand-0 Opan the selected itemn, or open a dialog to select a file to open.

Cammand-P Print the current document.

Command=3 Sawve the current document.

Carmmand-W Close the front window. Press Command-Option-W ta close all windows of
the app.

Cammand=0 Quit the current app.

Caommand-0ption-Esc Choose an app to Force Quit.

Cammand-Tab Switch ta the next most recently used app among Your ofan apps.

Command-Shift-5 Opean the Screenshot utility. You can also take scresnshots using the

fellowing shortcuts:
= Press Command-Shift-3 to take a screenshot of the entire screen.

= Press Command-=Shift-4 to take a screenchot of a salected area of the
SCraen.

m -SPARKLINES/Progress Bars

What good are goals if you can't track against them?

Sheets make it simple to see a visual representation of your progress using SPARKLINES.



Easily embed a miniature bar chart inside any cell.

=SPARKLINE(B2:C2,{"charttype","bar";"max",C2})

A B

C

o

Sales Rep| YTD Sales Sales Goal Progress
2 A $275,000 $1,000,000  |42/e
3 B $325,000 $1,000,000 ™= i ®
4 C $159,000 $1,000,000
D $456,000 $1,000,000
6 E $678,233 $1,000,000
7 F $785,289 $1,000,000
8 G $365,777 $1,000,000

m -Self-destructing emails:

In Gmail, this is known as "Confidential Mode"

*Navigate to compose an email
eLocate the m icon at the bottom
Click & set the expiration date

You can even require an SMS passcode for the recipient to open the message!

Confidential mode

Recipients won't have the option to forward, copy, print, or download

this email. Learn more

SET EXPIRATION

Expires in 1 week

REQUIRE PASSCODE

-

Fri, Sep 24, 2021

All passcodes will be generated by Google. (3)

(® No SMS passcode

m -Split View:

(O 5SMSs passcode

Cancel Save

If you're like me, you never have enough screen real estate.



Here's how to 2X your viewable area:
Hover your pointer over the full-screen button m in the upper-left corner.

->Tile left or right
->Click a window on the other side

BOOM!

2 apps, 1 screen

Use two Mac apps side by side in Split View

With Split View, you can fill your Mac screen with two apps, without having to manually
move and resize windows.

Enter Split View

If you're using macQ3 Catalina or later:

1. Hover your pointer over the full-screen button . in the upper-left comer of a window. Or click and hold
the button.

2. Choose "Tile Window to Left of Screen” or "Tile Window to Right of Screen” from the menu. The
window then fills that side of the screen.

m -QR CODES
Everyone has a smartphone these days...
Generating an easily scannable image to drive traffic to your site seems like a no-brainer.

*Copy + paste formula below
*Change "Al" to the cell with your URL



-m Free QR code

=IMAGE("https://t.co/WUIcCmxXEDY"&A1&"™)

e~ o~ B T O100% » $§ % 0 00 123 Defaut(ari. ~ 36 <~ B I S A @ H

B& -

Website URL QR Code|
> https://twitter.com/blakeaburge

* https://www.espn.com/

+ https://www.canva.com/

* |https://www.traderjoes.com/home
* https://www.youtube.com/

m -Mute Conversations:

We've all been there.

Copied on an email chain with several other people, on a topic that's somewhere south of relevant to you.
No worries. Just mute the conversation.

*Select the message

*Click the 3 dot icon above
*Select "mute”

' If you're part of an email conversation that's no longer relevant to you, mute the conversation.

Muting keeps future responses to that thread out of your inbox so you can focus on important
messages.

Mute a conversation

1. In Gmail &, select the conversation you want to mute.
2. Click More ¢ and select Mute.

3. After you mute a conversation, it's removed from your inbox and archived. You can still see the
conversation in All Mail with a Muted label applied.


https://t.co/WUIcmxXEDY

m -Digital Signatures:

Have a PDF you need to sign?

Let's skip all the printing, physical signing, scanning, etc.

Using the "preview" app you can easily create a digital signature.

All you need is a pen, a white piece of paper, & your Mac's camera.
https://t.co/3ACdKofmOl

® -ARRAYFORMULA

Why enter 3 formulas when 1 will do the trick?

Array formulas allow you to process data in a "batch” rather than individual calculations.

Here we pull the monthly sales for each "widget" & calculate the Q1 total.

Formula:=ARRAYFORMULA(C3:C5+C7:C9+C11:C13)

A B [+

1 Company X

2 January Revenue Per ltem
Widget #1 $25,356.00

4 Widget #2 $23,339.00

5 Widget #3 $21,569.00

6 February Revenue Per ltem
Widget #1 $25,555.00

8 Widget #2 $26,789.00

9 Widget #3 $27,456.00

10 March Revenue Per ltem

11 Widget #1 $30,125.00

12 Widget #2 $31,255.00

13 Widget #3 $31,269.00

14

15 Item Q1 Total Revenue

16 Widget #1

17 Widget #2

18 Widget #3

m -Preview emails:

Converting from Outlook & miss your "preview pane?"



https://t.co/3ACdKofm0I

Gmail lets you preview as well.

*Head to settings > all-settings
eLocate Inbox > enable reading pane

Now you can read mail right next to your inbox - Read & write faster while adding more context.

Reading pane: Enable reading pane - provides a way to read mail right next to your
list of conversations, making mail reading and writing mail faster and
adding more context.

Reading pane position
O No split

Right of inbox

(O Below inbox

m -Digital Signatures:

Have a PDF you need to sign?

Let's skip all the printing, physical signing, scanning, etc.

Using the "preview" app you can easily create a digital signature.

All you need is a pen, a white piece of paper, & your Mac's camera.
https://t.co/3ACdKofmOl

m -QUERY

Search large data sets to find & extract items that meet specified criteria.

Formula:=QUERY(B3:C14, "select B where C>50000")

Here, we'll pull out the names from column B with over 50K followers in column C.

This is only the beginning of what QUERY can do!


https://t.co/3ACdKofm0I

2 Twitter Accounts # of Followers Accounts Over 50K Followers
3 Sahil Bloom 446,900
4 Amanda Natividad 61,100
5 David Morris 8,948
6 Jaime Schmidt 52,400
7 Dickie Bush 144,400
8 Wes Kao 76,600
9 Jesse Pujji 106,600
10 Katelyn Bourgoin 44,800
1 Dave Kline 11,500
12 Codie Sanchez 110,700
13 Nathan Baugh 49,600
14 Steph Smith 67,800

m -Auto-advance:

"Inbox zero" sure sounds nice.

Speed up the process of deleting emails by enabling "auto-advance."

Once on, Gmail won't send you back to your inbox each time you delete an opened message.
*Head to settings > all-settings

*Advanced > auto-advance
*Enable

General Labels Inbox Accounts andImport Filters and Blocked Addresses

Forwarding and POP/IMAP Add-ons Chatand Meet Advanced Offline Themes

Auto-advance

Show the next conversation instead of your inbox
after you delete, archive or mute a conversation. You
can select whether to advance to the next or
previous conversation in the "General" Settings page.

Enable

O Disable

®m -Annotate PDF's
While the preview app doesn't allow for text editing, it does provide some other pretty cool features.

By selecting the "markup"” toolbar, you can unlock multiple collaborative options:

*Add notes



*Suggest changes
*Sketch, draw, & share ideas.

Here's how:

Annotate a PDF in Preview on Mac

Although you can’t edit the text of a PDF in Preview, you can use the markup tools to provide feedback or
write down something you want to remember. The editing tools in the Markup toolbar are ideal for
collaborating—use them to suggest changes to a PDF and to respond to suggestions.

Search for text in a PDF.
Click to show the Markup toolbar.
Click to highlight text in your PDF,

The Markup
toolbar Zoom in and out.
L] e M- M" ’_“ul 2} =¥ u rd d LY 4
T - vl - " D = 0- -
L |
PDF editing tools |

1. In the Preview app == on your Mac, click the Show Markup Toolbar button @) (if the Markup toolbar
isn't showing).

2. Use the tools in the toolbar to mark up the PDF (or use the Touch Bar).

m -SPLIT

Split text from one cell into multiple.

Formula: =SPLIT(B3,“ ")

This will take the contents of B3 and separate it into C3 & D3 based on the delimiter you place inside " ".

In this case, we'll separate the First & Last names based on the "space" in between.



2 Twitter Accounts First Name|Last Name
3 Sahil Bloom

4 Amanda Natividad
5 David Morris

6 Jaime Schmidt
David Zabinsky

8 Wes Kao

9 Jesse Pujji

10 Katelyn Bourgoin
11 Dave Kline

12 Codie Sanchez

13 Nathan Baugh

14 Steph Smith

m -Keyboard shortcuts:

Save time using Gmail's built-in shortcuts.

Navigate your inbox, format text: Archive, delete, & more.
*Head to settings > all-settings

*Locate general > keyboard shortcuts

*Select "on"

Need a complete list?

Type "shift + ?" with Gmail open.




Shortcuts you can use

You can use keyiboard shortcuts 1o navigate your inbox and messages, format text, and complete actions like

archiving and deleting.

To see a complete list of keyboard shortouts, including which need to be turned on, type 7 when you have

Gmail open.

Note: Keyboard shorteuts work differently on PC and Mac computers. On PCs, you'll use Ctrl instead of 36.

Compose & chat

Action

Previous message in an open conversation
Mext message in an open conversation
Focus main window

Foecus latest chat or compose
Advance to the next chat or composa
Advance to previous chat or compose
Send

Add ec recipients

Add bee recigients

Access custom from

Insert a link

o to next misspelled word (Mac only)

Open spelling suggestions

Formatting text

Actions

m -Custom shortcuts:

Shortcut

P

n

Shift + Esc

Esc

ctrl +.

Ctrl +,

#/Ctrl + Enter
3£/Ctrl + Shift +
3 /Ctrl + Shift + b
32/Ctrl + Shift «f
HCtrl + k

¥+,

HiCtrl+m

Did you know you can make a keyboard shortcut for almost anything?

Go to:

System Preferences->Keyboard
->App Shortcuts->Click the +

Have a menu option you use all the time, but a shortcut doesn't exist?

No worries. Create your own!



Create keyboard shortcuts for apps on Mac

You can create your own keyboard shortcuts for menu commands in any macOS app, including the Finder.
This might be useful if a global shortcut, which works the same with most apps, conflicts with a specific
app shortcut. In this case, you could create a new key combination.

1. On your Mac, choose Apple menu @ > System Preferences, click Keyboard, then click Shortcuts.

2. Select App Shortcuts on the left, click the Add button -, click the Application pop-up menu, then
choose a specific app or All Applications.

For example, to set a shortcut for a TextEdit command, choose TextEdit. If an app isn't in the list,
choose Other, then locate the app using the Open dialog. Some apps may not allow you to set
keyboard shortcuts.

If you want to set a shortcut for a menu command that appears in many apps, choose All Applications.

3. In the Menu Title field, type the menu command for which you want to create a shortcut, exactly as the
command appears in the app, including the > character (type ->), ellipses (type three periods without
spaces or press Option-; (semi-colon)), or other punctuation.

For example, to set a shortcut for the default ligature command in TextEdit (Format > Font > Ligatures
> Use Default), you would type Format->Font->Ligatures->Use Default in the Menu Title field. Toset a
shortcut for the Export as PDF command (File > Export as PDF...), you would type File->Export as
PDF... in the field.

4. Click in the Keyboard Shortcut field, press the key combination that you want to use as the keyboard
shortcut, then click Add.

For example, press the Control, Option, and Z keys at the same time. You can use a key only once in a
key combination.

m -Timesavers:
Assuming you're signed in to your Google account, head on up to your browser's address bar:

From there type: "https://t.co/BeKgYV7g31"

Boom! A new Google sheet is created for you on the fly from anywhere on the web.

(Works for docs, slides, calender, etc.)


https://t.co/BeKgYV7g31
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Thanks for reading!

If you learned something new...

Follow me @blakeaburge for weekly threads on business, productivity, & building a better you.
Check out my newsletter:

"While You Were Away"

*The best of Twitter

*In your inbox

*Every Sunday
https://t.co/O8nkCLIEIV
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